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ECommerce definition and types 

of commerce 
Ecommerce (e-commerce) or electronic 

commerce, a subset of ebusiness, is the 

purchasing, selling, and exchanging of goods 

and services over computer networks (such as 

the Internet) through which transactions or 

terms of sale are performed electronically. 

Contrary to popular belief, ecommerce is not 

just on the Web. In fact, eCommerce was alive 

and well in business to business transactions 

before the Web back in the 70s via EDI 

(Electronic Data Interchange) through VANs 

(Value-Added Networks). Ecommerce can be 

broken into four main categories: B2B, B2C, 

C2B, and C2C.  

B2B (Business-to-Business) 

 Companies doing business with each other 

such as manufacturers selling to distributors 

and wholesalers selling to retailers. Pricing is 

based on quantity of order and is often 

negotiable. 

 

B2C (Business-to-Consumer) 

 Businesses selling to the general public typically 

through catalogs utilizing shopping cart 

software. By dollar volume, B2B takes the prize, 

however B2C is really what the average Joe has 

in mind with regards to ecommerce as a whole. 

 Having a hard time finding a book? Need to 

purchase a custom, high-end computer system? 

How about a first class, all-inclusive trip to a 

tropical island? With the advent ecommerce, all 

three things can be purchased literally in 

minutes without human interaction. Oh how far 

we've come! 

C2B (Consumer-to-Business) 

 A consumer posts his project with a set budget 

online and within hours companies review the 

consumer's requirements and bid on the 

project. The consumer reviews the bids and 

selects the company that will complete the 

project. Elance empowers consumers around 

the world by providing the meeting ground and 

platform for such transactions. 

C2C (Consumer-to-Consumer) 

 There are many sites offering free classifieds, 

auctions, and forums where individuals can buy 

and sell thanks to online payment systems like 

PayPal where people can send and receive 

money online with ease. eBay's auction service 

is a great example of where person-to-person 

transactions take place everyday since 1995.  

 Companies using internal networks to offer 

their employees products and services online--

not necessarily online on the Web--are 

engaging in B2E (Business-to-Employee) 

ecommerce. 

 G2G (Government-to-Government), G2E 

(Government-to-Employee), G2B (Government-

to-Business), B2G (Business-to-Government), 

G2C (Government-to-Citizen), C2G (Citizen-to-

Government) are other forms of ecommerce 

that involve transactions with the government--

from procurement to filing taxes to business 

registrations to renewing licenses. There are 

other categories of ecommerce out there, but 

they tend to be superfluous. 

What is the difference between E-

commerce and E-Business? 
 

 E-commerce is buying and selling using an 

electronic medium. It is accepting credit and 
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payments over the net, doing banking 

transactions using the Internet, selling 

commodities or information using the World 

Wide Web and so on.  

 E-Business in addition to encompassing E-

commerce includes both front and back-office 

applications that form the engine for modern E-

commerce. E-business is not just about E-

commerce transactions; it's about re-defining 

old business models, with the aid of technology 

to maximize customer value. E-Business is the 

overall strategy and E-commerce is an 

extremely important facet of E-Business.  

 Thus e-business involves not merely setting up 

the company website and being able to accept 

credit card payments or being able to sell 

products or services on time. It involves 

fundamental re-structuring and streamlining of 

the business using technology by implementing 

enterprise resource planning (ERP) systems, 

supply chain management, customer 

relationship management, data ware housing, 

data marts, data mining, etc. 

Features of eCommerce 

Technology 
 

Interactivity 

 

Technologies used in eCommerce require 

consumer interactions in order to make an 

individual feel as though he is an active 

participant in the transaction process. As a 

result, eCommerce technologies can adjust to 

each individual’s experience. For example, while 

shopping online, an individual is able to view 

different angles of some items, add products 

into a virtual shopping cart, checkout by 

inputting his payment information and then 

submit the order. 

Personalization 

 

Technologies within eCommerce allow for the 

personalization and customization of marketing 

messages groups or individuals receive. Pearson 

Education states that companies can base such 

messages on individual characteristics of a 

consumer. An example of personalization 

includes product recommendations based on a 

user's search history on a Web site that allows 

individuals to create an account. 

Information Richness 

 

Users can access and utilize text messages and 

visual and audio components to send and 

receive information. Pearson Education states 

that such aspects provide a rich informational 

experience in regards to marketing and the 

consumer experience. An individual may see 

information richness on a company's blog if a 

post contains a video related to a product and 

hyperlinks that allow him to look at or purchase 

the product and send information about the 

post via text message or email. 

Universal Standards 

 

Individuals, businesses and governments only 

use one set of technological, media and 

Internet standards to use eCommerce features. 

Consequently, universal standards help simplify 

interactions. An individual can see these 

standards while shopping online, as the process 

to purchase items is similar on Web sites that 

use eCommerce technologies. Similarly, when 

an individual creates an online account, the site 
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generally requires an individual to create a 

username and password so he can access his 

account. 

Ubiquity 

 

Because they are web-based, eCommerce 

technological features are available anywhere 

you can connect to the Internet at any time, 

including homes, offices, video game systems 

with an Internet connection and mobile phone 

devices. Because eCommerce is ubiquitous, the 

market is able to extend its traditional 

geographic boundaries and operating hours. An 

example includes the ability to access the 

Internet wherever there is a Wi-Fi hotspot, such 

as a cafe or airport. Moreover, individuals who 

have cell phones with data capabilities can 

access the Internet without a Wi-Fi connection. 

Information Density 

 

The use of eCommerce reduces the cost to 

store, process and communicate information, 

according to Pearson Education. At the same 

time, accuracy and timeliness increase; thus, 

making information accurate, inexpensive and 

plentiful. For example, the online shopping 

process allows a company to receive personal, 

shipping, billing and payment information from 

a customer all at once and sends the customer's 

information to the appropriate departments in 

a matter of seconds. 

User-Generated Content 

 

Social networks use eCommerce technologies 

to allow members, the general public, to share 

content with the worldwide community, 

according to Kurt Grashaw in an article for the 

Web site Merchant Circle. Consequently, 

consumers with accounts can share personal 

and commercial information to promote a 

product or service. When a company has a 

professional social networking account, a 

member of the same social network has the 

option of associating himself with the company 

or a product by saying he likes or recommends 

it. When an individual updates his status on a 

social networking account, he may also mention 

a product or company by name, which creates 

word-of-mouth advertising. 

Global Reach 

 

Technologies within eCommerce seamlessly 

stretch across traditional cultural and national 

boundaries and enable worldwide access. 

Pearson Education states that instead of just 

offering goods and services to a population 

within a specific boundary, businesses can 

market to and serve an international audience. 

The Internet and multilingual Web sites, as well 

as the ability to translate a Web page, allows 

international visitors all over the globe to access 

company Web sites, purchase products and 

make business interactions. 

Understanding the World Wide 

Web 
The world wide web is a system of Internet 

servers that supports hypertext and multimedia 

to access several Internet protocols on a single 

interface. The World Wide Web is often 

abbreviated as the web or www.  

 

 The World Wide Web was developed in 1989 

by Tim Berners-Lee of the European Particle 

Physics Lab (CERN) in Switzerland. The initial 
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purpose of the Web was to use networked 

hypertext to facilitate communication among its 

members, who were located in several 

countries. Word was soon spread beyond CERN, 

and a rapid growth in the number of both 

developers and users ensued. In addition to 

hypertext, the Web began to incorporate 

graphics, video, and sound. The use of the Web 

has reached global proportions and has become 

a defining element of human culture in an 

amazingly short period of time.  

 

 In order for the Web to be accessible to 

anyone, certain agreed-upon standards must be 

followed in the creation and delivery of its 

content. An organization leading the efforts to 

standardize the Web is the World Wide Web 

(W3C) Consortium. Take a look at the W3C 

Consortium Web site to get an idea of its 

activities. A lot of the material is technical 

because, after all, the Web is a technical 

phenomenon.  

Protocols of the Web 

 The surface simplicity of the Web comes from 

the fact that many individual protocols can be 

contained within a single Web site. internet 

protocols are sets of rules that allow for 

intermachine communication on the Internet. 

These are a few of the protocols you can 

experience on the Web:  

HTTP (HyperText Transfer Protocol): transmits 

hyptertext over networks. This is the protocol of 

the Web. 

 

E-mail (Simple Mail Transport Protocol or 

SMTP): distributes e-mail messages and 

attached files to one or more electronic 

mailboxes. 

FTP (File Transfer Protocol): transfers files 

between an FTP server and a computer, for 

example, to download software. 

Hypertext and links: the motion 

of the Web 
 The operation of the Web relies primarily on 

hypertext as its means of information retrieval. 

HyperText is a document containing words that 

connect to other documents. These words are 

called links and are selectable by the user. A 

single hypertext document can contain links to 

many documents. In the context of the Web, 

words or graphics may serve as links to other 

documents, images, video, and sound. Links 

may or may not follow a logical path, as each 

connection is created by the author of the 

source document. Overall, the Web contains a 

complex virtual web of connections among a 
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vast number of documents, images, videos, and 

sounds.  

 Producing hypertext for the Web is 

accomplished by creating documents with a 

language called hypertext markup language, or 

html. With HTML, tags are placed within the 

text to accomplish document formatting, visual 

features such as font size, italics and bold, and 

the creation of hypertext links.  

<p> This is a paragraph that shows the 

underlying HTML code. <strong>This sentence is 

rendered in bold text</strong>. <em>This 

sentence is rendered in italic text.</em> </p>  

 HTML is an evolving language, with new tags 

being added as each upgrade of the language is 

developed and released. Nowadays, design 

features are often separated from the content 

of the HTML page and placed into cascading 

style sheets (css). This practice has several 

advantages, including the fact that an external 

style sheet can centrally control the design of 

multiple pages. The World Wide Web 

Consortium (W3C), led by Web founder Tim 

Berners-Lee, coordinates the efforts of 

standardizing HTML. The W3C now calls the 

language XHTML and considers it to be an 

application of the XML language standard.  

Pages on the Web 
 The backbone of the World Wide Web are its 

files, called pages or Web pages, containing 

information and links to resources - both text 

and multimedia - throughout the Internet.  

 Web pages can be created by user activity. For 

example, if you visit a Web search engine and 

enter keywords on the topic of your choice, a 

page will be created containing the results of 

your search. In fact, a growing amount of 

information found on the Web today is served 

from databases, creating temporary Web pages 

"on the fly" in response to user searches. You 

can see an example of such a page below, taken 

from the search engine Hakia. This page only 

exists as a result of a search. 

Access to Web pages can be accomplished in all 

sorts of ways, including:  

Entering a Web address into your browser and 

retrieving a page directly 

Browsing through sites and selecting links to 

move from one page to another both within 

and beyond the site 

Doing a search on a search engine to retrieve 

pages on the topic of your choice (See: The 

World of Search Engines) 

Searching through directories containing links 

to organized collections of Web pages (See: The 

World of Subject Directories) 

Clicking on links within e-mail messages 
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Using apps on social networking sites or your 

mobile phone to access Web and other online 

content 

Retrieving updates via RSS feeds and clicking on 

links within these feeds (See: RSS Basics) 

Retrieving files on the Web: the URL and 

Domain Name System 

URL 
url stands for uniform resource locator. The URL 

specifies the Internet address of a file stored on 

a host computer, or server, connected to the 

Internet. Web browsers use the URL to retrieve 

the file from the server. This file is downloaded 

to the user's computer, or client, and displayed 

on the monitor connected to the machine. 

Because of this relationship between clients and 

servers, the Web is a client-server network.  

 

 Underlying the functionality of a URL is a base 

numeric address that points to the computer 

that hosts the file. This numeric address is 

called the ip (internet protocol) address. The 

host portion of a URL is translated into its 

corresponding IP address using the domain 

name system (dns). The DNS is a worldwide 

system of servers that stores location pointers 

to the computers that host networked files. 

Since numeric strings are difficult for humans to 

use, alphneumeric addresses are employed by 

users. Once the translation is made by the DNS, 

the browser can contact the server and ask for 

the specific file designated in the URL.  

 For example, the DNS translates 

www.microsoft.com into the IP address 

207.46.19.254.  

Anatomy of a URL  
 Every file on the Internet, no matter what its 

protocol, has a unique URL. Each URL points to 

a specific file located in a specific directory on 

the host machine. This is the format of a URL:  

 protocol://host/path/filename  

 For example, this is a URL from the site of the 

U.S. Senate of a live video stream sent by a 

camera pointed at the U.S. Capitol:  

 http://www.senate.gov/general/capcam.htm  

 This URL is typical of addresses hosted in 

domains in the United States. The structure of 

this URL is shown below.  

Protocol:  http 

Host computer name: www 

Second-level domain name: senate 

Top-level domain name: gov 

Directory name: general 

File name: capcam.htm 

 Note how much information about the content 

of the file is present in this well-constructed 

URL.  

 Several generic top-level domains (gTLDs) are 

common in the United States: 

m commercial enterprise 

edu  educational institution 

gov  U.S. government entity 

mil  U.S. military entity 

net  network access provder 

org  usually nonprofit organizations 
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 In addition, dozens of domain names have 

been assigned to identify and locate files stored 

on servers in countries around the world. These 

are referred to as country codes, and have been 

standardized by the International Standards 

Organization as ISO 3166. For example: ch  

Switzerland 

de Germany 

jp Japan 

uk  United Kingdom 

Difference between FTP, HTTP, 

TCP/IP. Please explain.? 
n order to fetch a web page for you, your web 

browser must "talk" to a web server and when 

web browsers talk to web servers, they speak a 

language known as HTTP. 

 FTP refers to a network protocol which is 

responsible for transferring files from one 

computer to another computer. 

 TCP/IP is a basic communication language or 

protocol of the internet. It can also be used as a 

communications protocol in a private network 

(either intranet, Extranet) 

FTP means the File Transfer Protocol, File 

Transfer Protocol (FTP) is a standard network 

protocol used to exchange and manipulate files 

over a TCP/IP-based network 

 HTTP means the Hyper Text Protocol. it used 

for HTTP is a request/response standard typical 

of client-server computing. 

 TCP/IP is the communication protocol for the 

internet and it used for internet and other 

similar protocols. 
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HTML 

What Is HTML? 

HTML stands for HyperText Markup Language. Developed by scientist Tim Berners-Lee in 1990, 

HTML is the "hidden" code that helps us communicate with others on the World Wide Web 

(WWW). 

HTML is the "language" that web pages are written in - in fact, HTML stands for "hypertext 

mark-up language." But what does that mean?  

Hyper is the opposite of linear. Old-fashioned computer programs were necessarily linear - that 

is, they had a specific order. But with a "hyper" language such as HTML, the user can go 

anywhere on the web page at any time.  

Text is just what you're looking at now - English characters used to make up ordinary words. 

Mark-up is what is done to the text to change its appearance. For instance, "marking up" your 

text with <b> before it and </b> after it will put that text in bold. 

Language is just that. HTML is the language that computers read in order to understand web 

pages. 

Do I Need to Understand HTML to Create My Website? 

Actually, no. There are many website-building programs on the market that don't require 

knowledge of HTML at all. You tell the program what you want, and the program creates the 

HTML for you. 

However, it's definitely to your benefit to understand how HTML works, even if you're using 

one of these programs, so you can take full advantage of everything they have to offer. And if 

you're a do-it-yourselfer, creating your own website from scratch, including the HTML code, can 

be a lot of fun. 

What Do I Need to Write HTML? 

A computer, an Internet browser (if you're reading this web page now, you've obviously got 

both), and a word-processing program such as Microsoft's Notepad or WordPad, or Mac's 

Simple Text. Technically speaking, that's all you need. 
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What Can I Do with HTML? 

 HTML coding is what makes your website look like a website, rather than just plain text. 

With HTML, you can:  

 Create titles, headings and subheadings. 

 Make a bulleted or numbered list. 

 Delineate paragraphs. 

 Put text in bold or italics. 

 Add pictures and links to your site. 

 And much more. 

HTML Basic Document 

 

<!DOCTYPE html>   

 <html> 

 <head> 

 <title>Title of document goes here</title> 

 </head> 

 <body> 

 Visible text goes here... 

 </body>  

</html> 

Basic Tags 

 <h1>Largest Heading</h1> 

 <h2> . . . </h2> 

 <h3> . . . </h3> 

 <h4> . . . </h4> 

 <h5> . . . </h5> 

 <h6>Smallest Heading</h6> 

 

 <p>This is a paragraph.</p> 

 <br> (line break) 

 <hr> (horizontal rule) 

 <!-- This is a comment --> 

Formatting 

 <b>Bold text</b> 

 <code>Computer code</code> 

 <em>Emphasized text</em> 

 <i>Italic text</i> 

 <kbd>Keyboard input</kbd>  

 <pre>Preformatted text</pre> 

 <small>Smaller text</small> 

 <strong>Important text</strong> 
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 <abbr> (abbreviation) 

 <address> (contact information) 

 <bdo> (text direction) 

 <blockquote> (a section quoted from 

another source) 

 <cite> (title of a work) 

 <del> (deleted text) 

 <ins> (inserted text) 

 <sub> (subscripted text) 

 <sup> (superscripted text) 

Links 

Ordinary link: <a 

href="http://www.example.com/">Link-

text goes here</a> 

 Image-link: <a 

href="http://www.example.com/"><img 

src="URL" alt="Alternate Text"></a> 

 Mailto link: <a 

href="mailto:webmaster@example.com">S

end e-mail</a> 

Bookmark: 

 <a id="tips">Tips Section</a> 

 <a href="#tips">Jump to the Tips 

Section</a> 

Images 

<img src="URL" alt="Alternate Text" 

height="42" width="42"> 

 Styles/Sections 

<style type="text/css"> 

   h1 {color:red;} 

   p {color:blue;} 

 </style> 

 

 <div>A block-level section in a 

document</div> 

 <span>An inline section in a 

document</span> 

Unordered list 

<ul> 

   <li>Item</li> 

   <li>Item</li> 

 </ul>  

Ordered list 

 <ol> 

   <li>First item</li> 

   <li>Second item</li> 

 </ol>  

Definition list 

 <dl> 

   <dt>Item 1</dt> 
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     <dd>Describe item 1</dd> 

   <dt>Item 2</dt> 

     <dd>Describe item 2</dd> 

 </dl> 

Tables 

<table border="1"> 

   <tr> 

     <th>table header</th> 

     <th>table header</th> 

   </tr> 

   <tr> 

     <td>table data</td> 

     <td>table data</td> 

   </tr> 

 </table> 

Iframe 

 

<iframe src="demo_iframe.htm"></iframe> 

Forms 

 <form action="demo_form.asp" 

method="post/get">  

 

<input type="text" name="email" size="40" 

maxlength="50"> 

 <input type="password"> 

 <input type="checkbox" 

checked="checked"> 

 <input type="radio" checked="checked"> 

 <input type="submit" value="Send"> 

 <input type="reset"> 

 <input type="hidden"> 

 <select> 

 <option>Apples</option> 

 <option 

selected="selected">Bananas</option> 

 <option>Cherries</option> 

 </select> 

<textarea name="comment" rows="60" 

cols="20"></textarea> 

 </form> 

Entities 

 &lt; is the same as < 

 &gt; is the same as > 

 &#169; is the same as © 

Tag Description 

<!--...--> Defines a comment 

<!DOCTYPE>  Defines the document type 

<a> Defines a hyperlink 
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<abbr> Defines an abbreviation 

<acronym> Not supported in HTML5. Defines an acronym 

<address> Defines contact information for the author/owner 

of a document 

<applet> Not supported in HTML5. Deprecated in HTML 

4.01. Defines an embedded applet 

<area> Defines an area inside an image-map 

<article>New Defines an article 

<aside>New Defines content aside from the page content 

<audio>New Defines sound content 

<b> Defines bold text 

<base> Specifies the base URL/target for all relative URLs 

in a document 

<basefont> Not supported in HTML5. Deprecated in HTML 

4.01. Specifies a default color, size, and font for all 

text in a document 

<bdi>New Isolates a part of text that might be formatted in a 

different direction from other text outside it 

<bdo> Overrides the current text direction 

<big> Not supported in HTML5. Defines big text 

<blockquote> Defines a section that is quoted from another 

source 

<body> Defines the document's body 

<br> Defines a single line break 

<button> Defines a clickable button 

<canvas>New Used to draw graphics, on the fly, via scripting 

(usually JavaScript) 

<caption> Defines a table caption 

<center> Not supported in HTML5. Deprecated in HTML 

4.01. Defines centered text 

<cite> Defines the title of a work 

<code> Defines a piece of computer code 

<col> Specifies column properties for each column 

within a <colgroup> element  

<colgroup> Specifies a group of one or more columns in a 

table for formatting 

<command>New Defines a command button that a user can invoke 

<datalist>New Specifies a list of pre-defined options for input 

controls 

<dd> Defines a description of an item in a definition list 

<del> Defines text that has been deleted from a 

document 

<details>New Defines additional details that the user can view or 

hide 

<dfn> Defines a definition term 

<dir> Not supported in HTML5. Deprecated in HTML 

4.01. Defines a directory list 
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<div> Defines a section in a document 

<dl> Defines a definition list 

<dt> Defines a term (an item) in a definition list 

<em> Defines emphasized text  

<embed>New Defines a container for an external (non-HTML) 

application 

<fieldset> Groups related elements in a form 

<figcaption>New Defines a caption for a <figure> element 

<figure>New Specifies self-contained content 

<font> Not supported in HTML5. Deprecated in HTML 

4.01. Defines font, color, and size for text 

<footer>New Defines a footer for a document or section 

<form> Defines an HTML form for user input 

<frame> Not supported in HTML5. Defines a window (a 

frame) in a frameset 

<frameset> Not supported in HTML5. Defines a set of frames 

<h1> to <h6>  Defines HTML headings 

<head> Defines information about the document 

<header>New Defines a header for a document or section 

<hgroup>New Groups heading (<h1> to <h6>) elements 

<hr>  Defines a thematic change in the content 

<html> Defines the root of an HTML document 

<i> Defines a part of text in an alternate voice or 

mood 

<iframe> Defines an inline frame 

<img> Defines an image 

<input> Defines an input control 

<ins> Defines a text that has been inserted into a 

document 

<kbd> Defines keyboard input 

<keygen>New Defines a key-pair generator field (for forms) 

<label> Defines a label for an <input> element 

<legend> Defines a caption for a <fieldset>, < figure>, or 

<details> element 

<li> Defines a list item 

<link> Defines the relationship between a document and 

an external resource (most used to link to style 

sheets) 

<map> Defines a client-side image-map 

<mark>New Defines marked/highlighted text 

<menu> Defines a list/menu of commands 

<meta> Defines metadata about an HTML document 

<meter>New Defines a scalar measurement within a known 

range (a gauge) 

<nav>New Defines navigation links 

<noframes> Not supported in HTML5. Defines an alternate 
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content for users that do not support frames 

<noscript> Defines an alternate content for users that do not 

support client-side scripts 

<object> Defines an embedded object 

<ol> Defines an ordered list 

<optgroup> Defines a group of related options in a drop-down 

list 

<option> Defines an option in a drop-down list 

<output>New Defines the result of a calculation 

<p> Defines a paragraph 

<param> Defines a parameter for an object 

<pre> Defines preformatted text 

<progress>New Represents the progress of a task 

<q> Defines a short quotation 

<rp>New Defines what to show in browsers that do not 

support ruby annotations 

<rt>New Defines an explanation/pronunciation of 

characters (for East Asian typography) 

<ruby>New Defines a ruby annotation (for East Asian 

typography) 

<s> Defines text that is no longer correct 

<samp> Defines sample output from a computer program 

<script> Defines a client-side script 

<section>New Defines a section in a document 

<select> Defines a drop-down list 

<small> Defines smaller text 

<source>New Defines multiple media resources for media 

elements (<video> and <audio>) 

<span> Defines a section in a document 

<strike> Not supported in HTML5. Deprecated in HTML 

4.01. Defines strikethrough text 

<strong> Defines important text 

<style> Defines style information for a document 

<sub> Defines subscripted text 

<summary>New Defines a visible heading for a <details> element 

<sup> Defines superscripted text 

<table> Defines a table 

<tbody> Groups the body content in a table 

<td> Defines a cell in a table 

<textarea> Defines a multiline input control (text area) 

<tfoot> Groups the footer content in a table 

<th> Defines a header cell in a table 

<thead> Groups the header content in a table 

<time>New Defines a date/time 

<title> Defines a title for the document 

<tr> Defines a row in a table 
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<track>New Defines text tracks for media elements (<video> 

and <audio>) 

<tt> Not supported in HTML5. Defines teletype text 

<u> Defines text that should be stylistically different 

from normal text 

<ul> Defines an unordered list 

<var> Defines a variable 

<video>New Defines a video or movie 

<wbr>New Defines a possible line-break 
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What is CSS? 

 CSS stands for Cascading Style Sheets 

 Styles define  how to display HTML elements 

 Styles were added to HTML 4.0 to solve a problem 

 External Style Sheets can save a lot of work 

 External Style Sheets are stored in CSS files 

An HTML document can be displayed with different styles: See how it works 

HTML was never intended to contain tags for formatting a document. 

HTML was intended to define the content of a document, like: 

 

<h1>This is a heading</h1> 

<p>This is a paragraph.</p> 

When tags like <font>, and color attributes were added to the HTML 3.2 specification, it 

started a nightmare for web developers. Development of large web sites, where fonts and 

color information were added to every single page, became a long and expensive process. 

 To solve this problem, the World Wide Web Consortium (W3C) created CSS. 

 In HTML 4.0, all formatting could be removed from the HTML document, and stored 

in a separate CSS file. 

 All browsers support CSS today. 

 CSS Saves a Lot of Work! 

 CSS defines HOW HTML elements are to be displayed. 

 

Styles are normally saved in external .css files. External style sheets enable you to change 

the appearance and layout of all the pages in a Web site, just by editing one single file! 

CSS Example 

p 

 { 

 color:red; 

 text-align:center; 
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 } 

Example 2 

h3 

 { 

 color:red; 

 text-align:left; 

 font-size:8pt; 

 } 

 

 

JavaScript Introduction 
JavaScript is the world's most popular programming language. It is the language for HTML and 

the web, for servers, PCs, laptops, tablets, smart phones, and more. 

JavaScript is a Scripting Language 

A scripting language is a lightweight programming language. 

JavaScript is programming code that can be inserted into HTML pages. 

JavaScript inserted into HTML pages, can be executed by all modern web browsers.  

JavaScript is easy to learn. 

JavaScript: Writing Into HTML Output 

Example 

 document.write("<h1>This is a heading</h1>"); 

document.write("<p>This is a paragraph</p>");  

  You can only use document.write in the HTML output. If you use it after the document 

has loaded, the whole document will be overwritten.  

JavaScript: Reacting to Events 

Example 



 

 

 <button type="button" onclick="alert('Welcome!')">Click Me!</button> 

 

The alert() function is not much used in JavaScript, but it is often quite handy for trying out 

code. 

 

The onclick event is only one of the many HTML events you will learn about in this tutorial.  

JavaScript: Changing HTML Content 

Using JavaScript to manipulate the content of HTML elements is a very powerful functionality. 

Example 

 x=document.getElementById("demo")  //Find the element 

 x.innerHTML="Hello JavaScript";    //Change the content  

You will often see document.getElementByID("some id"). This is defined in the HTML DOM. 

The DOM (Document Object Model) is the official W3C standard for accessing HTML elements.  

You will find several chapters about the HTML DOM in this tutorial. 

JavaScript: Changing HTML Images 

This example dynamically changes the source (src) attribute of an HTML <image> element: 

The Light bulb 

 Click the light bulb to turn on/off the light 

JavaScript can change most of the attributes of any HTML element, not only images.  

JavaScript: Changing HTML Styles 

Changing the style of an HTML element, is a variant of changing an HTML attribute.  

Example 

 x=document.getElementById("demo")  //Find the element  

x.style.color="#ff0000";           //Change the style 

Try it yourself » 

JavaScript: Validate Input 



 

 

JavaScript is commonly used to validate input. 

Example 

 if isNaN(x) {alert("Not Numeric")}; 

Did You Know?  JavaScript and Java are two completely different languages, in both concept 

and design. 

Java (invented by Sun) is a more complex programming language in the same category as C. 

ECMA-262 is the official name of the JavaScript standard. 

JavaScript was invented by Brendan Eich. It appeared in Netscape (a no longer existing browser) 

in 1995, and has been adopted by ECMA (a standard association) since 1997. 

JavaScript is the world's most popular programming language. It is the language for HTML and 

the web, for servers, PCs, laptops, tablets, smart phones, and more. 

JavaScript is a Scripting Language 

A scripting language is a lightweight programming language. 

JavaScript is programming code that can be inserted into HTML pages. 

JavaScript inserted into HTML pages, can be executed by all modern web browsers.  

JavaScript is easy to learn. 

document.write("<h1>This is a heading</h1>"); 

document.write("<p>This is a paragraph</p>");  

 

  You can only use document.write in the HTML output. If you use it after the document 

has loaded, the whole document will be overwritten.  

JavaScript: Reacting to Events 

Example 

 <button type="button" onclick="alert('Welcome!')">Click Me!</button> 

The alert() function is not much used in JavaScript, but it is often quite handy for trying out 

code. 

The onclick event is only one of the many HTML events you will learn about in this tutorial.  



 

 

JavaScript: Changing HTML Content 

Using JavaScript to manipulate the content of HTML elements is a very powerful functionality. 

Example 

 x=document.getElementById("demo")  //Find the element 

 x.innerHTML="Hello JavaScript";    //Change the content  

 

You will often see document.getElementByID("some id"). This is defined in the HTML DOM. 

The DOM (Document Object Model) is the official W3C standard for accessing HTML elements.  

You will find several chapters about the HTML DOM in this tutorial. 

JavaScript: Changing HTML Images 

This example dynamically changes the source (src) attribute of an HTML <image> element: 

The Light bulb 

Click the light bulb to turn on/off the light 

 

JavaScript can change most of the attributes of any HTML element, not only images.  

JavaScript: Changing HTML Styles 

Changing the style of an HTML element, is a variant of changing an HTML attribute.  

Example 

 x=document.getElementById("demo")  //Find the element  

x.style.color="#ff0000";           //Change the styleJavaScript: Validate Input 

JavaScript is commonly used to validate input. 

Example 

 if isNaN(x) {alert("Not Numeric")}; 

Did You Know?  JavaScript and Java are two completely different languages, in both concept 

and design. 

Java (invented by Sun) is a more complex programming language in the same category as C. 



 

 

ECMA-262 is the official name of the JavaScript standard. 

JavaScript was invented by Brendan Eich. It appeared in Netscape (a no longer existing browser) 

in 1995, and has been adopted by ECMA (a standard association) since 1997. 

JavaScript Form Validation 

 

JavaScript can be used to validate data in HTML forms before sending off the content to a 

server. 

Form data that typically are checked by a JavaScript could be: 

has the user left required fields empty? 

has the user entered a valid e-mail address? 

has the user entered a valid date? 

has the user entered text in a numeric field? 

Required Fields 

The function below checks if a field has been left empty. If the field is blank, an alert box alerts a 

message, the function returns false, and the form will not be submitted: 

 function validateForm() 

 { 

 var x=document.forms["myForm"]["fname"].value; 

 if (x==null || x=="") 

   { 

   alert("First name must be filled out"); 

   return false; 

   } 

 } 

The function above could be called when a form is submitted: 

Example 



 

 

 <form name="myForm" action="demo_form.asp" onsubmit="return validateForm()" 

method="post"> 

 First name: <input type="text" name="fname"> 

 <input type="submit" value="Submit"> 

 </form> 

E-mail Validation 

The function below checks if the content has the general syntax of an email. 

This means that the input data must contain an @ sign and at least one dot (.). Also, the @ must 

not be the first character of the email address, and the last dot must be present after the @ 

sign, and minimum 2 characters before the end: 

 function validateForm() 

 { 

 var x=document.forms["myForm"]["email"].value; 

 var atpos=x.indexOf("@"); 

 var dotpos=x.lastIndexOf("."); 

 if (atpos<1 || dotpos<atpos+2 || dotpos+2>=x.length) 

   { 

   alert("Not a valid e-mail address"); 

   return false; 

   } 

 } 

The function above could be called when a form is submitted: 

Example 

 <form name="myForm" action="demo_form.asp" onsubmit="return validateForm();" 

method="post"> 

 Email: <input type="text" name="email"> 

 <input type="submit" value="Submit"> 



 

 

 </form> 

What is XHTML? 
 XHTML is a web language used to write webpages. With XHTML, you decide where to arrange 

text and graphics on web pages as well as their structure and layout. XHTML is designed to 

specify the logical organization of a webpage.  

 XHTML stands for Extensible Hyper Text Markup Language. It is the next phase in the evolution 

of HTML. The last version of HTML before XHTML was HTML 4.01. The first version of XHTML 

was XHTML 1.0, and the current version of XHTML is XHTML 1.1. XHTML is alot like HTML, in fact 

the same tags are used in XHTML that are used in HTML. Fundamentally, XHTML is HTML with a 

stricter syntax and standards for cleaner and more efficient code. While it has not done so yet, 

XHTML is aimed to eventually replace HTML.  

 XHTML documents have a file extension of .htm or .html. It is better to use the .html extension 

as that is the modern standard. 
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Adobe Dreamweaver 
 Adobe Dreamweaver is one of the most popular professional web development software 

packages. Dreamweaver is a complex product suitable for everything from simple page design to 

development of dynamic pages written with ColdFusion, PHP, ASP, CSS, XML, XSLT, and 

JavaScript. 

Adobe's Dreamweaver is far more than a simple HTML editor. With its support for a great 

number of scripting languages (PHP, ASP, CSS and more), Dreamweaver is the most powerful, 

most fully featured web developer tool. 

 Available for both Mac and Windows operating systems, this cross platform development tool 

allows users to preview websites in their web browsers. It combines a great WYSIWYG editor, an 

FTP client, and a convenient scripting environment, which supports advanced autocomplete and 

script formatting options. Also, the latest CS4 version features a Live View mode which allows 

the designers and the developers to view their changes in real time - whenever they make a 

change to their website's code, the Live View will give an instant feedback to their changes. This 

is a great time-saving feature, which can help the professionals avoid errors and which allows 

them to easily experiment with different sets of code. 

 

What is Dreamweaver? 

Dreamweaver CS3 is a powerful Hypertext Markup Language (HTML) editor used by 

professionals, as well as beginners. The program makes it easy for designers to create visually 

attractive, interactive Web pages without having to know HTML or JavaScript. However, 

Dreamweaver CS3 enables the experienced professional to write and edit HTML using the code 

editor. Dreamweaver also gives the opportunity to create web pages and learn HTML coding as 

you go along, by giving you the option of a split screen with code and design. 

If your department doesn’t already own a copy of Dreamweaver, you may talk to your IT 

Department about downloading a free 30 day trial from the Adobe website at  

Before you start with Dreamweaver. 

There are a few things that need to happen before you start your web page in Dreamweaver. 

The very first thing you need to know is your audience.  Who is your target audience?  What will 

they be looking for in your website?  Will they be looking for entertainment, information, or 

education?  What type of equipment do they use? 

When you have that information, you need to plan out your website.  What information will go 

on the home page?  How many pages will your site have?  How will you navigate around the 

pages?  One of the best features about a web site is that they are not linear, but hypermedia.  

Websites are like a CD compared to an audio tape.  They can be accessed in different sequences 



 

 

depending on what each person is looking for in your website.  What images or other objects 

will you want included in the site?  A good way to lay all this out is to use sticky notes and lay 

them out to see how your site will flow, and what your layout will be.  You may then want to 

create a flow chart that will show how your pages will be linked. 

Next, gather all your content, such as any documents, images, movies, scripts, etc that will  

Once you have this information, you can begin to create your site by setting up the folders you 

will need for the site.  Start with the root folder (the site folder) and everything else will need to 

go in this one folder.  Even a small site must have a root folder and should also have an images 

folder and maybe even a content folder.  Larger sites may have those folders and then go on to 

add other subfolders for each section of the web site.  Each website must have its own root 

folder.  

 

Because some browsers read text case sensitive it is a good idea to have all your file names in 

lower case letters.  To make them more readable it is acceptable to use the underscore _ to 

separate words in your names.  It is best for your home page to be named index.htm.  Each 

website has a unique address or URL (Uniform Resource Locator). A browser will recognize 

index.htm as the home or opening page of your website.  It is possible to locate a home page 

with alternate names, but the URL would have to be typed out including the home page name, 

including the file extension.  In other words, to locate the home page named index.htm you 

would type in an address of http://www.website.com.  But if your home page is named 

mysite.htm, you would have to type http://www.website.com/mysite.htm.  This is not 

imperative, but using the index file will make it more easily accessible to others.  Also 

Dreamweaver automatically recognizes index.htm and you do not have to go through an extra 

step to designate the page as your home page. 

 



 

 

HTML – Hypertext Markup Language 

 

HTML is a set of codes that describe the appearance of web documents and all the objects on 

the page.  Objects could be anything from text to images to movies.  The HTML codes are called 

tags.  The tags are enclosed with the < and > symbols so the programs reading them recognize 

that they are tags.  Most items have an opening tag < > and a closing tag < />.  For example 

<title> This is the title </title>.  The tags signify the beginning of an item and the end of that 

item.  Each item is called an element.  Each element can have attributes and the attributes can 

have values. Values follow an equal sign and are in quotes. HTML tags are not case sensitive, so 

it doesn’t make any difference if you use upper or lower case letters, however lower case is the 

norm.   

<ELEMENT  ATTRIBUTE= VALUE > or, think of it this way: 

 

<CAR  MODEL= CAMRY   COLOR= RED > 

<SANDWICH  BREAD= WHEAT > 

 

All HTML documents are required to have certain elements. 

 

<html>   This designates the beginning of the document. 

 

<head>    This section contains the document title, keywords, meta tags, scripts 

<title> Document title </title> 

</head>  This is the end of the Head section 

 

<body>    This designates the beginning of the Body section 

  All the content of the page would be in the body section 

</body>  This is the end of the Body section 

 



 

 

</html>  This is the end of the HTML document 

 

The World Wide Web is overseen by a not for profit group called the W3C (World Wide Web 

Consortium).  They have hundreds of members from many countries and many companies.  

They are dedicated to providing Interoperability on the web so everyone has equal access to the 

web.  From the W3C website: 

 

The World Wide Web Consortium (W3C) is an international 

 consortium where Member organizations, a full-time staff,  

and the public work together to develop Web standards.  

W3C's mission is: 

 To lead the World Wide Web to its full potential by  

 developing protocols and guidelines that ensure  

 long-term growth for the Web.  http://www.w3.org/Consortium/Overview 

 

One free online site that provides many tutorials with cut and paste examples is W3 Schools at 

http://www.w3schools.com/  

 

 

A few common tags are:  

<p> paragraph <br>  line break <td> table data 

<hr> Horizontal Rule (line) <H1> Heading 1 <img> image 

<a> anchor <a HREF > link &nbsp non-breaking space 

 

 

http://www.w3.org/
http://www.w3.org/Consortium/Overview
http://www.w3schools.com/


 

 

File Size, Download Time and Screen Resolution 

A couple of other items that need to be mentioned are download time and screen resolution. 

The web site you are creating is meant for viewing.  To make it as accessible as possible it is a 

good idea to limit the amount of information on each page.  Most viewers will not wait more 

than 8 seconds for a page to load.  Larger files take longer to download. If it takes too long, they 

will just go somewhere else. The pages may need to be divided up into more pages with less 

information or images on each page or the images may need to be optimized (smaller file size) 

for the web.  

 

There are various size monitors and many have different resolutions.  Resolution (for monitors) 

has to do with the number of pixels (colored squares) across and down the screen.  Today’s 

monitors can be set to various resolutions. Some older monitors are set for a page resolution of 

640 pixels wide x 480 pixels high.  Currently many monitors are set to a resolution of 800 x 600 

or, like the monitors in the training room, 1024 x 768.   Viewers do not like to have to scroll side 

to side so some website developers limit the page size to less than 800 pixels, usually 760 pixels 

to be safe.  Before creating your web site you need to determine who will be viewing the site to 

decide the page size you want to use.  To be absolutely safe you may still want to create pages 

for the 640 pixel wide pages.  When you are choosing images for your web site, look at the pixel 

dimensions of the image.  For example a digital camera may take a picture that is 3000 pixels 

wide.  To put that image on a web site that image would have to be downsized quite a bit to fit 

on a page. Use a graphics program such as Photoshop or Fireworks to optimize your images.  

You want to create them to the proper size outside of Dreamweaver and then bring them into 

your web site at the proper screen size and the smallest file size. 

 

Accessibility 

To keep in line with 

Accessibility  

guidelines and regulations, 

Dreamweaver has some 

helps  that you can use to 

remind you to add certain 

properties and attributes to 

make your pages more 

accessible to those with visual 

or other disabilities.   

From the Edit menu choose 

Preferences to get the box 

shown on the right. 



 

 

Then click on the Category called Accessibility.   

By default the four top checkboxes are checked.  If these are not checked, check them.  When 

you are creating your web pages Dreamweaver will automatically open dialog boxes to allow 

you to add accessibility options and will alter your code appropriately.  The other two check 

boxes do not alter the code, but change how the program works, so these can be left as is.   



 

 

 

Dreamweaver  Start Page 

Start Page - Welcome Screen 

 

This is the page you get when you first start up Dreamweaver CS3.  This gives you the 

option to open many different kinds of pages.  The start page can open each time you 

start Dreamweaver or it can be disabled by checking the Do not show again box. If you 

decide later you want it back go to Edit > Preferences > General and check the Show 

start page option. 

 

Open existing pages 

Create new sites or pages 



 

 

The Dreamweaver CS3 Designer Workspace 

This is the new Designer layout of the Dreamweaver CS3 where the panels are docked on the right 

side.  There is also an alternate Coder workspace that is similar to the HomeSite/Coder-Style 

workspace for those that prefer to do most of their web page creating in the HTML code view.  This 

can be changed at startup or by choosing Change Workspace in the Preferences area under the 

Edit Menu.   

The only choice in the Macintosh is the floating  style workspace where each pa

Dockable 
Panels 

Document Window 

 

 This area displays the current document  

  as you create and edit it. 

  

Menu Bar 

Insert Bar 

Property Inspector 

Open documents 

Panels can be collapsed or expanded by 

clicking on the expander arrow. 



 

 

Insert Bar – This is used to Insert components in your web page. 

Click icon to add images, links, forms, create layouts. All items on the Insert 

Bar can be found on the Insert Menu, but it is usually easier to use the 

buttons on the Insert Bar. 

 

Each Category offers different object to add to your page. 

This is the Layout category.  This gives options for laying out the web 

page.  In Standard mode, tables can be inserted by rows and columns 

looking like they would in a browser. Expanded mode temporarily 

adds cell spacing and padding so editing will be easier, but does not 

appear as the table would in design view. 

Each category has a group of items each with buttons to let you add or edit objects or text.  

The Text category allows insertion of text and paragraph formatting tags. 

The Forms category includes items such as text field, radio buttons, and list menus. 

The Insert Bar 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Status Bar 

 

The left side of the document Status Bar has a Tag Selector.  This allows you to select an 

item by clicking on the tag.  

The right side of the status bar gives information about the document, including the size of 

the document window and approximate download time.  Dreamweaver uses a 28.8 

modem speed as a default.  This can be changed in the Preferences area under the Edit 



 

 

The Document Toolbar is where you can change your document window views   

 Code shows HTML code only  

 Split shows both the design view and the code view 

Click here to view your page in 

a true browser or use the 

Shortcut F12 
Enter your page title here.  The page title and the 

file name do not have to be the same. 

The Document Toolbar

The Property Inspector is context sensitive.  It changes for each object or text item, and 

shows the attributes for that item.  It gives an easy way to view and edit the properties of 

each item.  The expander arrow will expand or collapse the property inspector to show or 

hide properties.  Any time the property inspector is not visible, go to Window > 

Properties on the Menu bar.   

 

Another feature of Dreamweaver CS3 is the right-click context menu.  When you are 

working on an item a right-click will bring up a menu with the most useful commands and 

properties related to that particular item. 

Files Panel  

(similar to Windows Explorer) 

 

Files (such as images) can be dragged 

Docked Panels 



 

 

Starting the Web Site 

 

The first step in building a web site in Dreamweaver is to define the site.  At this point, the site is 

already planned on paper.  Now, create the folders and sub folders on the hard drive. You want 

to have something similar to folder below, where gainesville_site is the root folder and content 

and images are your subfolders.  If you have all your images and content gathered, it is best to 

put it all in the proper folders at this time.  Now we can define our site with Dreamweaver by 

specifying what the names of the folders are, and where they are located. 

 

 

 

 

 

 

 

 

 

To define your site in Dreamweaver: 

1.  Open Dreamweaver CS3. 

2.  Go to the menu and choose Site > Manage Sites. 

3.  Click New. 

4.  Choose Site. 

 When the site definition dialog box opens choose the Advanced tab. 

  (The basic tab will work, but it has more options than we need at this time.) 

 



 

 

 

 

5.  

Choose Local Info. 

6.  In the Site Name Text box, type the name of your website (i.e. Gainesville). 

7.  In the Local Root Folder area, click on the folder icon.  Navigate to where your root 

 folder is stored.  You should see the contents of your root folder 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

8.  Click on Select. 

9.  Make sure Refresh Local File List Automatically and Enable Cache are checked. (Unless 

you are working on a very large site, then uncheck Enable Cache) 

10. Click OK.  Click OK if the initial cache  message pops up. 

11. Click Done. 

 

Creating the Home Page 

Begin by creating a new page 

 

1. From the menu, choose File > New. 

a. Or use the Start Up page and Choose New HTML page 

 

2. Choose a Blank page and HTML then click Create. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

3. The next thing you do is save your page.  It may look like an empty page, but if you look 

at the code view, you will see there is already information about your page.  Use either 

File>Save or CTRL + S.  On the open document tab if a * is showing it means the 

page has not been saved since changes have been made.  It is always best to save your 

work continually as you go along.  Remember this will be the home page, so we want 

the file to be named index.html.  The best practice is to name your files using all lower 

case letters with no special characters except the underscore (_) and no spaces. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

4. In the Document Toolbar type the title of your web page.  Call this Gainesville Home 

Page or My Home Page.  Unlike filenames, the title can contain spaces and/or 

characters. Use a unique and descriptive title for your page.  This title shows on the blue 

title bar when you are viewing the page on the web. 

5. Press Enter to apply the title to your home page. 

6. This page will have a table in it to organize information.  Tables are set up with rows 

going across the page and columns going down the page.  Cells make up the table and 

have properties called cell spacing which is the space between each cell and cell padding 

which is the space from the cell wall to the information placed inside the cell.   

7. Go to the Common Category of the Insert bar.  Choose the Table button. 

8. When you choose the table button the Table dialog box pops up.  Enter the number of 

rows (4) and columns (2).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Text 

Cell Spacing 

Cell Padding 5 rows 

3 Columns 

Sizing Handles 

9. If you do not want a Border to show, you would enter 0 in the border text box.  For this 

project we will set Cell padding (space around the content, but within the cell) to 5 

and Cell spacing (space between the cells) to 0.  Table widths can be in pixels or in 

percentages (a % of the screen size).  You can set the table width in pixels for a fixed 

width table or in % for a flexible table.  For example a table with a 75% width will be 

75% of the browser window no matter how the browser is resized.  If you don’t set a 

table width, the table will expand to fit the content and in a browser window will 

expand to fill the page.  For today’s project, set the Table Width to 90%.  If necessary, 

the table properties can be changed in the Property Inspector at any time.  Also the 

width and height can be changed by clicking and dragging the borders.  It is not 

necessary to set a height for a table.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

10. To create the proper look for our home page, we will merge the cells in the top row and 

the two middle rows in the 2
nd

 column.  To merge cells, select the cells and click on the 

merge cells button on the Property Inspector (or go to the Modify Menu and choose 

Table>Merge cells).  Make sure the table is selected and choose to center it using the 

alignment buttons in the property inspector.   

 

 



 

 

Adding Content to a Page 

 

1.  In the first cell of your table, type the heading for the page.  The Delete key, the Backspace 

key and Edit>Undo all will undo actions and remove items from your page. To go to the next 

line, hit the Enter key.  This will create a new paragraph which will give some white space above 

and below the text.  If you want to go to a new line, but not create a new paragraph, hold down 

the shift key and press enter.  This will create a line break but not a new paragraph. 

 

2.  To enter an image, go to the Common Insert Bar, and choose the image button (it looks like a 

tree).  The Image Source dialog box will open.  This will show a preview of selected images. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

3.  Choose your images folder.  Choose the image you want and click OK. 

Your image is now on the page where the cursor (insertion point) was located.  The Image can 

be resized.  The best practice however, is to have your picture sized properly before inserting it 

into your page by using a graphics program.  Alternatively, you can just find the image in your 

files panel and click hold and drag the image file into place.   

 

4.  Enter an alternate text for your picture.  This is a text equivalent that will display if the 

picture does not load properly or if the person viewing your page does not have graphic 

capabilities, or for those reading  the page using a screen reader.  This is one of the 

accessibility options available, and is a good practice.  Enter the description of your image in the 

Alt text box in the Property Inspector.  If your image has a text equivalent elsewhere on the 

page, such as a caption, or if the image is purely decorative, using the Alt drop down set the Alt 

attribute to <empty>.   

 

 

 

 

 

 

 

 



 

 

5.  To direct your audience to other websites, make some hyperlinks.  Type something 

descriptive such as Go to the City of Gainesville website.  Insert a paragraph break by pressing 

the Enter key.  The enter key applies a paragraph break which gives white space above and 

below the text.  (Remember, to move to the next line without that extra space, use shift + 

Enter.) 

 

6.  Select the words City of Gainesville .  In the Property Inspector, in the Link text box, type 

in the full URL of the link for example    http://www.cityofgainesville.org/    and press the Enter 

key.  This will enter a hyperlink in your document and will show up underlined.  Typically the 

color of the hyperlink is blue and Dreamweaver sets this automatically. 

 

 

 

7.  The link is now a working link and that is all that needs to be done.  However, in the Target 

dropdown box there are choices to make the link open in a new browser.  Choosing _Blank in 

the target drop down will make the link open in a new browser window. 

8.  Press Enter to make another paragraph and repeat the hyperlink process for the remaining 

links. 

9.  Add footer information to the page.  Items such as Created by, Copyright info and a Last 

Modified date for example.  To add the date, place your cursor in the last cell.  Then, using the 

Common Insert bar, choose the Date icon.  The date can be in many formats and if you check 

the box on the bottom it will update automatically each time the page is saved.   

10.  Format the headings on the page by selecting the text and using the Format drop down box 

in the Property Inspector. There are several heading options.  We format the headings to give 

the headings meaning.  Formatting a specific heading will make the content more meaningful to 

search engines and will assist screen readers. 

 

Save and Preview your page.   

  



 

 

Styles 

To make the page look better and/or more appealing, we add style to our page.  We can do this 

in different ways.  One way is to use the property inspector and add size and color to text or 

other objects on the page.  A better more efficient way to add style is to use CSS or Cascading 

Style Sheets.  This is covered in a later workshop.  Check out the handout for the CSS class at  

 

Look at the Page Properties by clicking on the button (labeled Page Properties) on the 

Property Inspector.  It will open the dialog box below and we will work on Appearance.  

(Another way to access Page Properties is to go to the Menu - Modify>Page Properties.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

For this project we will be setting a background color for our page.  Click on the small square 

next to Background color.  The color picker pops up and gives the option to choose any 

color.  Choose a color and press the Apply button.  This will apply the background to the 

page and show what the page will look like. You have the option of changing it as many 

times as you want.  This project is using color #FFFFCC.  When you have the color you want 

press the OK button. (Although our monitors will theoretically display over 16 million colors, 

there are only 216 Web Safe  colors.  Those are the colors that will normally look the same 

in Internet Explorer, Firefox, Safari or Netscape on PC’s or Macs.  Web safe colors can be 

recognized by the hexadecimal value.  Each web safe color will have 3 pairs of numbers 

consisting of 00, 33, 66, 99, CC, FF. Any time you are picking a color, you will see the 

hexadecimal value displayed.  The cubes in the color picker are the 216 colors traditionally 

considered to be web-safe. Most current monitors can see all 16 million colors so this is not 

as important as it once was.)   

Creating additional pages 

When creating new pages, there are a couple of options.  You could start the same way you did with the 

first page by opening a new blank html page.  Another way is to duplicate the original page and delete 

what you don’t need and add the new content.  One way to duplicate the page is to open it in 

Dreamweaver and then use the Save As command in the File menu giving the page a new name. 

Another way is to right click the page name in the files panel, choose edit and then duplicate.   

 

After creating the new page and giving the page a new name 

o Delete all unnecessary information 

o Merge or split cells as necessary 

o Add content – Format as necessary (ie. H1) 

o Add images 

o Give the page an appropriate title and save 

 

For the second page in our site we are going to add a text file (city_facts.txt) and a new nested table to 

add a few pictures to the bottom of the page.   The .txt file can be selected in the files panel and dragged 

onto the page or it can be opened by double clicking in the files panel and then copied and pasted into 

the page.  Dragging files may create extra line breaks that will need to be deleted.  Copying and pasting 

may take an extra step, but seems to add fewer extra spaces. 

 

For the third page we will use an existing table of facts created in Word (services.doc). 

As with the .txt file, the .doc file can be selected in the files panel and dragged onto the page or it can be 

opened by double clicking in the files panel and then copied and pasted into the page.   



 

 

 

The last page in the site will be a map page with a rollover image. A rollover image is two images located 

in the same space. One image is the base image. Then, when the mouse is over the image the second 

image shows. Move the mouse and the first image takes its place again. 

 

1. Using your first page, create a new HTML page. Save the page. Give it a title (In the Document 

toolbar). This will be our Map page. Type and format the Heading (Gainesville Driving Directions) on the 

page.  

2. Click to place your cursor in the proper table cell.  In the Common Insert bar, click on the small 

triangle next to the image button. In the drop down box, choose Rollover Image. 

 

 

 

 

 

 

 

 

3. Use the browse buttons to locate the images. Select the images to go on the page. The standard 

non-rollover picture is the Original image. Also check Preload Rollover Image to make the image cache 

in the browser so the picture will load quickly. As with all images, type in an alternate text.  Click OK. 

Save the page and preview in the browser. Test the rollover image to make sure the pictures swap out 

as the mouse rolls over the image.  

 

4. Add the directions text in the proper cell.   

Adding a Navigation Bar 

 

Once you have a group of web pages you want to make sure that anyone looking at the pages can 

maneuver through your site at will.  We will use a table to add a navigation bar. 

 



 

 

1.  Open your Home page.  Insert a table with 1 row and the # of columns to match the number of 

pages in your site.  Use 0 for border, cell spacing and add 10 in cell padding.  Set the width at 90%. 

Click OK. 

2.  The table is on the page and selected.  While it is still selected, use the Property Inspector to align 

the table on the page by choosing Center from the Align drop down box.  If the table is not selected, 

it can be selected easily by clicking on the tag in the Tag Selector on the Status bar.   

3.  Click in the first cell and drag your cursor through the cells to select the whole row.  Click on the 

Align Center button on the Property Inspector to align the contents of all the cells to the center. 

4.  Type a name for each page in each cell.   

5.  Select the name in the first cell. Using the Point to File button in the property inspector next to the 

Link text box, click hold and drag to the proper file in the file panel.  The Point to file button will 

automatically fill in the Link box for any file in your file panel. 

 

 

 

6.  Repeat the process for each page. 

7.  Save the page and preview it in the browser.  Make sure all the links work properly. Now we need a 

way to get back to the home page and move around the other pages. 

8.  On the Home page select the Navigation table by clicking in the table and then selecting the table 

tag in the tag selector in the status bar at the bottom of the page.  Copy the table (Edit> Copy or 

CTRL+C).  Open your other pages and paste (Ctrl + V) the table on each of the other pages in your web 

site. 

Another option is to use Dreamweaver’s Navigation Bar.  

This requires four images for each link that are exactly 

the same size.  You need an image for Up, Over, Down, 

and OverDown.  Once you have all four images prepared 

for each link, go to the Image insert button and choose 

Navigation Bar. 



 

 

Give the link an Element Name and then browse for each image.  Add the URL for the link and make sure 

Preload Images is selected.  You may want to select Show Down Image  initially for the page you are 

currently working on. Decide if you want the bar to be vertical or horizontal and whether you need it to 

be in tables.  Once the first link is finished, click on the plus to add additional links. When finished, click 

OK and you will have a new Navigation Bar on your page. 

 

When your bar is finished, you can select the Navigation Bar and paste it on each of your other pages.  

Then from the Modify menu item, choose Navigation Bar and then you can change the initial state of the 

button for each current page.  

 

 



 

 

Test the Site  

Before you put your site on a server it is best to test it on your local machine.  

1.  Open your Browser (Internet Explorer, Netscape, Mozilla, etc.) 

2.  From the browser Menu bar choose File > Open.  Locate your root folder and choose 

your home page (index.htm).  Your site should open in the browser. 

3.  Test all the links, both the links to your pages as well as the external links to other sites. Test to make 

sure the email links works.  (Don’t send email; just make sure it brings up the email client.) 

Remember to get back to your site from other sites you may have to use the browser’s Back 

button. 

Post the website to a server 

 

There are a few ways to get the website live  and viewable by the public.  

Many departments have a public folder that will allow you to copy your website in the folder and get a 

URL so anyone can navigate to the website with a browser.   

Another way to post the site is to use FTP.  That is a File Transfer Protocol.  FTP is a process where the 

files are uploaded to a server and are then available for viewing. 

Check with your department IT person as to how this would be done in your department. 

Once you have a folder on the live server  you can go to Site > Manage Sites to edit the remote site 

information.  Then use the big blue Put arrow in the files panel to upload your files. 

Many email servers allow a certain amount of space for personal websites. 

Helpful Keyboard Shortcuts 

 

 

 

 

 

 

 

Command Shortcut 

Save CTRL + S 

Copy CTRL + C 

Cut CTRL + X 

Paste CTRL + V 

Clear Delete / Backspace 



 

 

 

Another shortcut is to use the mouse right click.  When you are working with an item on the page, if you 

right click on the item you will get a context menu.  This has many commonly used options for that 

particular item.  

 

You can create your own keyboard shortcuts.   

 From the edit menu choose Keyboard shortcuts.  Make a copy of the standard shortcuts (this 

way if you don’t like the new shortcuts you can always get back to the original set. 

 Give the copy a new name 

 Choose a command you would like to create a new shortcut for, for example Save All  

 Choose the keys you want to use. 

o If the key combination is already in use as a shortcut it will tell you and you can choose 

something else. 

 When you are happy with your shortcuts click Change and then OK 
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